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What’s New in Chief
Architect X7

Welcome to Chief Architect X7. This guide has been 
written to help our upgrading customers make a 
smooth transition from earlier versions of Chief 
Architect to Chief Architect X7. 

Contents
• Before You Begin
• New and Improved Features

Before You Begin
There are many new features in Chief Architect X7, and many existing features have changed. These changes 
affect the way Chief Architect functions, so it is very important to be familiar with them. 

• Getting Started Check List on page 1

• Files Created in Version X6 and Prior on page 3

• For Files Created in Version X5 and Prior on page 4

• For Files Created in Version X4 and Prior on page 4

• For Files Created in Version X3 and Prior on page 5

• For Files Created in Version X2 and Prior on page 5

Chief Architect X7 can open the .plan, .layout, .PL1, and .LA1 files from prior versions. Before opening any 
files created in earlier versions of Chief Architect, it is important to be aware of changes made in the newest 
version and the effect they may have on your legacy plan and layout files. For details, see For Files Created in 
Version X3 and Prior on page 5,  For Files Created in Version X2 and Prior on page 5. 

As in all software, every new program version introduces changes to its functionality as well as to the user 
interface. If you choose to bring a project forward, be sure to take a few moments to look it over in the new 
version and confirm that the new functionality does not require you to make any modifications. Particularly if 
you have an approaching deadline, you may find it best to finish the current project in the version of the 
software in which you began it. 

Getting Started Check List
The following checklist suggests steps you should take before migrating your files to Chief Architect X7. More 
information about each of these steps can be found after the checklist.

1. Check for and Install Program Updates
2. Migrate Legacy Library Files
3. Migrate Custom Graphics Files
4. Review the New Features List
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5. Review Your Preferences Settings
6. Create new custom Template Plan and Layout files
7. Set up Custom Toolbar Configurations
8. Backup Entire Plan
9. Check www.chiefarchitect.com for more information

1. Check for and Install Program Updates

Program updates contain improvements to the original release version and we recommend using the most 
current version available. By default, Chief Architect checks for program updates every day when you launch 
the program. Please note that program updates are available for download, which means that you need internet 
access to acquire them.

You can check for updates at any time: 

• Select Help> Download Program Updates from the menu. 

• Visit the Program Updates page on the Chief Architect Web site at www.chiefarchitect.com. 

2. Migrate Legacy Library Files 

Library content from previous program versions cannot be installed or copied into the Chief Architect X7 
library. If you upgraded from version X1 or later and have custom library content on your computer from that 
program version, the program installer will locate it and ask if you want to migrate it into the Chief Architect 
X7 library.  

You can import library files from versions X1 through X5 at any time by selecting Library> Import Library 
(.calib, .calibz) from the program menu. In addition, library files from versions 10 and prior can be imported 
by selecting Library> Convert Legacy (.alb) Library Files from the program menu.

3. Migrate Custom Graphics Files

If you have custom graphics files, including textures, images or backdrops, that you were using in a previous 
program version, you can copy them manually using your operating system for use in Chief Architect X7. 

• Copy custom texture files to the Chief Architect X7 Textures folder located in the Chief Architect X7 Data 
folder. 

• Copy custom image files to your Chief Architect X7 Images folder located in the Chief Architect X7 Data 
folder. 

• Copy custom backdrop files to your Chief Architect X7 Backdrops folder located in the Chief Architect X7 
Data folder. 

In Chief Architect X5 through X1, custom graphics were saved in the Chief Architect Data folder, as they are 
in version X7. In version 10 and prior, they were located in the program’s installation directory, in folders that 
began with “My”. Custom backdrops, for example, were saved in “My Backdrops”. 

Texture and image files are not listed in the Library Browser. These files can be assigned to material and image 
objects, however, which are stored in the library so it is important to retain them.

4. Review the New Features List 

There are a number of important reasons why you should familiarize yourself with the new and improved 
features in Chief Architect X7:

• New and improved features allow you to produce drawings more efficiently, so it is to your advantage to 
use them. 

• Some changes to existing functionality may affect your accustomed drawing style and thus your productiv-
ity if you are not aware of them. 

• New features may affect your choice of settings in your template files, as well as your preferred Preferences 
settings. 
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See New and Improved Features on page 6. 

5. Review Your Preferences Settings 

Any changes that you made to the Preferences settings in your previous version do not migrate into Chief 
Architect X7. You should review all the settings in the Preferences dialog to make sure that they are set to suit 
your drawing needs.

6. Create new custom Template Plan and Layout files 

Chief Architect X7 installs a selection of template plan and layout files that have been set up to take advantage 
of the program’s updated tools and features. For best results, it is recommended that you either: 

• Use the installed templates when creating new plans and layout files in Chief Architect X7

• Use the installed templates as the basis for creating new custom templates.

If you choose to continue using custom template files that you created in a previous program version, it is very 
important that you take the time to carefully review all the default settings in the file, making sure that they will 
continue to suit your needs in X7. First, make copies of your custom templates in the Chief Architect X7 
Templates directory The Templates directory is located in the Chief Architect X7 Data folder. Next, open each 
template as you would a regular plan or layout file, by selecting File> Open, and then save any changes you 
make by selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout template from 
the same program version, as well. As with a template plan, take the time to go through the layout template’s 
defaults and make sure they are suited for use in X7 and that their line weight scales do not conflict with those 
in your template plans.

7. Set up Custom Toolbar Configurations 

It is possible to migrate toolbar configuration files from previous versions to Chief Architect X7; however, it is 
not recommended because it is likely that you will be missing new tools available in version X7. 

Instead, we recommend that you set up your custom toolbars the way you would like them in Chief Architect 
X7. You may find it most effective to customize your toolbars as you get used to working in the new program 
version, rather than beforehand.  

8. Backup Entire Plan

Before migrating a legacy file created in Chief Architect X5 or prior, it is a good idea to open the plan in the 
program version in which is was created and use the Backup Entire Plan tool (Export Entire Plan in version X3 
and prior) to export the plan with all associated support files, including textures, backdrops and images.  

9. Check www.chiefarchitect.com for more information

If you have additional questions about the changes in Chief Architect, up to date information is available in the 
Support section of our web site. You can also post questions on the Chief Talk web forum at 
www.chieftalk.com.

Files Created in Version X6 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X6 or 
prior, bear in mind the following before you open legacy files in Chief Architect X7. 

1. Built-in Appliances

In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base cabinets had 
incorrect sizing data. In legacy plans opened in version X7, these appliances will not fit into the cabinet 
correctly and will need to be replaced. Built-in dishwashers are particularly affected.

2. Formatting of Bulleted and Numbered Lists

In Version X7, various improvements were made to the way lines of Rich Text are spaced. In legacy plans 
opened in Version X7, Rich Text objects with bulleted and numbered lists may require adjustments.
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3. Chief Blueprint Font

The Chief Blueprint font was improved for Version X6, with decreased top and bottom spacing. The change in 
spacing may increase the overall height of text objects using this font in X6 files opened in Version X7. X5 and 
prior legacy files will not be affected by this change.

For Files Created in Version X5 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X5 or 
prior, bear in mind the following before you open legacy files in Chief Architect X7. 

1. Named Values for Doors and Windows

In Version X6, the Named Values door_style_name, door_type_name, and window_type_name were shortened 
to style_name and type_name. Any object labels or text macros using these Named Values in legacy plans 
opened in Version X7 will need to be replaced.

For Files Created in Version X4 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X4 or 
prior, bear in mind the following before you open legacy files in Chief Architect X7. 

1. Roof Overhangs and Framing

In Chief Architect X4 and prior, roof overhangs were measured to the outside of the subfascia, whereas in 
Version X5, they are measured to the outside of the fascia or shadow boards, if present. In legacy plans opened 
in Version X5, this will not affect the appearance of roof planes in floor plan view because in X4 and prior, roof 
plane polylines represented the projected framing area whereas in Version X5 they represent the total projected 
area. But, the position of the fascia and subfascia will shift, as will the length of the rafters.

2. Door Swing Direction and Materials

In Chief Architect X4 and prior, exterior doors that swing outward display interior material on exterior side of 
door. This was corrected in Version X7. Doors modified to work around the old behavior could be affected in 
legacy plans opened in Version X5.

3. Door Swing Direction and Louvers

Improvements to door louver direction may affect louvers in all doors with the exception of bifold doors.

4. Wrapped Door/Window Lintels and Window Sills

In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those that were not 
wrapped. In legacy plans opened in Version X7, the extents of wrapped lintels and sills will be adjusted so that 
they equal their Extend setting.

5. Cabinet Feet

The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork symbol to insert 
into cabinets effectively. In Version X7, the offset is set in the Cabinet Specification dialogs. When legacy 
plans are opened in Version X5, cabinet foot offsets are set to 0 and transferred to their containing cabinet, if 
one exists. Any customized or independently placed cabinet feet will be affected.

6. Object Labels in Cross Section/Elevation Views

If a “Label” layer is turned on in a cross section/elevation view and objects of that type are visible in the view, 
then those objects’ labels will display in that view when the plan is opened in Version X7.

7. Transparent Materials

In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing were visible in 
rendered views even when their Index of Refraction was set to 1.0. When legacy plans are opened in Version 
X7, Transparent materials with an Index of Refraction of 1.0 are transferred to the General Material class and 
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assigned a Transparency value of 100%. This will not affect these materials’ appearance in ray trace views, but 
will make them completely invisible in rendered views.

8. Invisible Beams

The legacy Invisible Beam checkbox was removed from the Wall Specification dialog. When legacy plans are 
opened in Version X7, any Invisible Beam walls will be converted to Invisible Walls. 

For Files Created in Version X3 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X3 or 
prior, bear in mind the following before you open legacy files in Chief Architect X7.

1. Text Styles

The appearance of a number of objects that include text - including object labels, the North Pointer, Sun 
Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can now be controlled using Text 
Style. Their appearance may be altered somewhat in legacy plans opened in Chief Architect X7.

2. Light Sources

The illumination created by light fixtures and Added Lights was improved in Chief Architect X7. Lighting in 
legacy plans may appear noticeably brighter when viewed in version X7.

For Files Created in Version X2 and Prior
If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the following file 
management changes and structural enhancements before you open legacy files in Chief Architect X7.

1. Material textures, images, and backdrops

Chief Architect X2 and prior installed with a catalog of library content, including a selection of material 
textures, images, and backdrops. This library catalog is no longer installed with the program because it is now 
available for download on-demand, so it will be possible to open a legacy plan in version X7 and encounter 
numerous missing file warnings. To avoid this, we recommend using the Export Entire Plan feature in the 
original program version to create a folder that includes the plan and all associated textures, images, and 
backdrops before opening this file in X7. This tool is renamed Backup Entire Plan in version X7.

2. Floor and ceiling finish thicknesses

In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and objects such as 
railings, stairs, landings, cabinets, fixtures, and furnishings measured their Floor to Bottom height from the 
subfloor. These objects now measure their Floor to Bottom height from the floor finish surface by default, so it 
is possible that you may notice height changes for these objects - particularly in saved, annotated cross section/
elevation views.

3. Riser heights and landing thicknesses

The default Best Fit Riser Height for stairs that do not reach the next level has been updated from 9” (225 mm) 
in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X7.

4. Auto Adjust Height

The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust Height checkbox. If 
a cabinet, fireplace, fixture, furniture, or other library symbol had Follow Terrain unchecked in version X2 or 
prior and was located in a room with a floor height other than the default for the current floor, then the object’s 
Floor to Bottom Height will change to equal that room’s floor height. The object’s position in the model will 
not change, however. 

5. Adjustable Thickness Walls

In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a legacy plan file 
is opened in version X7 and these wall types are detected, they are replaced by an updated, non-generic wall 
type. Framed walls and Railings will also acquire 1/2” (13 mm) thick layers of sheetrock on each side.
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6. Stairwells defined by railings

Interior railings that used a generic, single-layer wall type drawn in older program versions will acquire layers 
of sheetrock when the plan is opened in version X7. This can affect the appearance of staircases where they 
join to a floor platform. To address this issue, select the railing and move it 1/2” (13 mm) away from the top 
edge of the staircase. 

7. Deck rooms

In legacy plans opened in Chief Architect X7, Deck rooms with Advanced Deck Framing built retain the 
framing but have Automatic Deck Framing turned off by default. Decks with no Advanced Deck Framing built 
are converted to Balcony rooms.

8. Material definitions and light sources

Settings in the Define Material dialog that affect materials’ appearance of brightness have been modified. The 
Ambient setting was removed, and the Diffuse setting for materials in legacy plans will be set to 100% when 
opened in version X7. 

The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified. Lights using Soft 
Shadows in legacy plans will be set to use Medium quality. The Light Diameter of light sources in legacy plans 
is capped at 4” (100 mm).

9. Structural Member Reporting

When a plan created in Chief Architect X2 or prior is opened in Chief Architect X7, Materials Lists are set to 
calculate Total Lineal Length. For a combination of lineal length and piece count, select Mixed Reporting in 
the Structural Member Reporting dialog.

10. Fill New Framing Members

In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief Architect X7 it 
applies to the entire plan. As a result, it is turned off by default in legacy plans opened in version X7.

New and Improved Features
The following is a list of  new and improved features 
in Chief Architect Version X7.

Program Overview

• New Line Weights  toggle for specification 
dialog preview panes.

File Management
• Plan Databases can no longer be accessed in the 

Chief Architect Viewer and Home Designer pro-
grams.

Preferences and Default 
Settings

• The Sun Angle and Line Properties settings in 
the Preferences dialog were moved to the CAD 
panel.

• New Dialog Previews setting allows you to 
choose whether Standard or Vector View dialog 
previews are used by default.

• Obsolete Use Triangles, Smooth Faces, Use 
Transparency, and Optimizations On settings 

were removed from the Preferences  dialog.
• Enhanced  settings in the Preferences dialog.
• The  tool is now available for walls and electrical 

objects.

Layers
• New Active Layer Display Options side win-

dow.

Editing Objects

• New Object Eyedropper  tool lets you apply 
selected attributes of one object to another, simi-
lar object. 

• The Select Same Type and Load Values to 
Make Same edit tools have been renamed Match 
Properties  and Apply Properties , respectively.
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• The Match Properties  and Apply Properties  
edit tools are how available for more objects, 
including framing and CAD.

• The Match Properties dialog now has a Search 
field.

• New Fillet All Corners  and Chamfer All 
Corners  edit tools.

• New Fillet Radius  and Chamfer Distance 

 edit tools replace double-clicking the Fillet 
Lines or Chamfer Lines buttons.

• Sticky Mode  is now available for the Fillet 
Lines  and Chamfer Lines  edit tools.

• The Delete Objects dialog was redesigned for 
greater ease of use.

• The Delete Objects dialog can now be used to 
delete schedules.

Walls, Railings, and Fencing
• The Wall Type Definitions dialog has been rede-

signed for greater ease of use.
• An individual wall can now have multiple framed 

layers with or without staggered studs. 

• The Set as Default  edit tool is now available 
for walls with the exception of Pony Walls.

• Framed walls are automatically assigned a label 
when wall framing is built. Custom labels can 
also be specified.

• The Same Wall Type edit handles are now avail-
able for curved walls.

• The Follow Stairs option is now available for 
Solid railings.

Rooms
• New Deck Support panel in the Room 

Specification dialog with enhanced settings for 
deck beams, deck posts, and deck post footings. 

• New default layers for Deck Beams, Deck Posts, 
and Deck Post Footings. 

• New Make Living Area Polyline  edit tool 
creates a polyline showing the extents of the Liv-
ing Area.

Doors and Windows
• Window heights can now be measured from the 

floor finish rather than the subfloor.

• Improved ability to apply door handles and locks 
directly from the Library Browser. 

• Handles and locks can now be assigned to Pocket 
Doors. 

• Labels for doors placed in railings now display. 

Foundations
• New settings in the specification dialog for 

Round Piers and Square Pads.
• New Count setting in the Build Foundation dia-

log lets you specify the number of automatically 
generated treated sill plates.

• Can now choose to lock a curved roof plane’s 
Radius to Roof Surface or its Angle at Ridge 

when using the Join Roof Planes  edit tool.

Roofs
• The Square Cut and Plumb Cut options in the 

Build Roof dialog now apply to Roof Trusses.

Stairs, Ramps, and Landings

• New Railing on Selected Edge  and Remove 
Railing from Selected Edge  edit tools for 
Landings. 

Framing

• New Post with Footing  tool. 
• New defaults dialogs for posts and beams. 
• Posts can now be specified as Treated and can be 

assigned a cross box in floor plan view. 
• Posts now display in front of beams in floor plan 

view. 
• The wall framing for bay, box, and bow windows 

now displays in floor plan view. 
• Lookout Spacing can now be specified in the 

Build Framing dialog. 
• When the thickness and depth of wall studs are 

equal, only a single stud is created at wall cor-
ners. 

• Improved rough opening framing for Pocket 
Doors. 

• New Join and Lap Ends  and Join and 
Mitre Ends  edit tools. 

• Framing members can now display labels.
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Trusses

• New Open Truss Detail  edit tool for Floor/
Ceiling and Roof Trusses.

Electrical
• All specification settings are now saved when an 

Electrical object is added to the library.
• Can now specify the default layer for electrical 

objects.
• The Reverse Symbol option is now available for 

Electrical objects.
• The default library object for 220V Outdoor Out-

lets can now be specified.
• A default electrical object’s specification dialog 

can now be accessed in the Electrical Defaults 
dialog.

• The Electrical Defaults dialog can now be 
accessed by double-clicking the Outlet, Light, or 
Switch toolbar buttons.

• The Set as Default  edit tool is now available 
for electrical objects.

Trim and Moldings

• New Add Molding to Selected Edge  and 

Remove Molding from Selected Edge  edit 
tools for Molding Polylines.

Cabinets
• Cabinet face items can now be split vertically as 

well as horizontally to produce a wide variety of 
custom configurations.  

• Obsolete Double and Triple Face options were 
removed from the Cabinet Specification dialogs. 

• The Diagonal Door and Lazy Susan settings 
were moved to the General panel of the Cabinet 
Specification dialogs. 

• The Stiles Between Double Doors setting was 
moved to the Door/Drawer panel of the Cabinet 
Specification dialogs. 

• Enhanced interface for positioning cabinet 
drawer handles. 

• Cabinet drawer sizes in the Materials List now 
reflect the size of the drawer box instead of the 
drawer front. 

• A cabinet’s toe kick material can now be speci-
fied. 

Other Objects
• New Ignore Room Moldings option for Soffits. 
• Wall Material Regions  and Custom Back-

splashes  can now be rotated in floor plan view.
• Primitive objects now have preview panes and 

enhanced Rotation controls in their specification 
dialogs.

The Library
• Electrical object previews in the Library Browser 

now use 3D symbols rather than 2D CAD blocks 
when viewed at folder level. 

• Custom symbols can now be imported directly 
into a specific folder in the User Catalog. 

• The Replace from Library  tool can now be 
used to replace one object with a larger one that 
does not fit in the available space. 

Materials
• The Select Material dialog now includes Plan 

Materials.
• Color Saturation and Luminance are now 

described using percentages.

View and Window Tools
• Fill Window Building Only  now excludes 

the terrain in cross section/elevation views.

3D Views
• The camera symbols associated with cross sec-

tion/elevation cameras can now be moved from 

one floor to another using the Up One Floor  

or Down One Floor  buttons.
• Cross section/elevation views can now have 

stepped cutting planes.
• Cross section/elevation views now have Resize 

Clip Plane edit handles regardless of the type of 
plan view symbol used.

• The Auto Detail  tool is now available in all 
Rendering Techniques.

Rendering and Ray Tracing
• Compute Caustics is now turned off by default 

for most Outdoor Ray Trace Configurations cre-
ated using the Ray Trace Assistant.
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• Sun Angles now have Make Shadow  and 

Delete Shadow  edit buttons.

Dimensions
• Dimensions can now be set to locate cabinet 

countertops, backsplashes, toe kicks, and mold-
ings

• Auto Exterior Dimensions can now be set to 
Ignore Interior Walls.

Text, Callouts, and Markers

• If a Leader Line  or Text Line with Arrow 

 is drawn with its tail end snapped to a text 
object, it will be placed on the same layer as the 
text object and inherit all of that layer’s attributes.

• Improved handling of formatted text pasted into 

Rich Text  from an outside application.

CAD Objects
• New Same Line Type edit handles let you draw a 

line segment beginning at the end of a selected 
CAD line, arc, open polyline, or spline and shar-
ing its line color, weight, style, and more.

• New transparent Arrow styles available for CAD 
objects and dimensions.

• The transparency of fill pattern lines can now be 
specified.

• When used in floor plan view, the Delete 
Temporary Points  tool now deletes all tem-
porary CAD points on all floors.

Project Management
• Space Planning room boxes now have a specifi-

cation dialog: their names, line and fill styles can 
be modified.

• The names of Wall Details in the Project Browser 
now correspond to each wall’s label.

Pictures, Images, and Walk-
throughs

• The size and resolution of an exported picture can 
now be specified, as can a transparent backdrop.

Importing and Exporting
• Improved handling of texture mapping and shad-

ing in COLLADA exports.

Custom Symbols
• New Insert into Terrain Hole option in the 

Symbol Specification dialog.

Schedules and Object Labels
• Objects listed in schedules can now be limited to 

those found in a specific room.

• New Create Schedule from Room  edit tool 
lets you create a schedule for the contents of a 
selected room.

• When rooms included in a Room Finish Schedule 
have identical objects in them, their total count 
will be stated in the Totals row.

Ruby Console
• New named values for framing objects and walls.


